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Dear Student:

Welcome fo the Learning Center and thank you for attending iMovie Basics. During this class
we will show you the basics of iMovie as well as some of the considerations when you are making a
film.

Using a hands-on approach, the class will guide you through the process of creating a short
film by using still pictures, camcorder footage, as well as audio clips. Following the principle that

iMovie is a video sequencer we will arrange the media elements in order to create our short movie.

iMovie will also allow you add fransitions between clips, as well as effects to enhance or
modify the appearance of the video.

The Learning Center also offers training sessions on most of the software that comes installed
in the Berklee Laptop Program. Please do not hesitate to stop by for software support or just to try our
music workstations.

Visit us at learningcenter.berklee.edu

(617) 747-2669 (150 Mass. Ave. Building)
Learning Center Staff
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[-3 - iMovie (Interface)

iMovie is a very easy and quick way to make your home movies Ioo'kﬁprofeslsionol.
As part of Apple iLife Suite it takes advantages of these other applications so you can
bring any type of media info your movie.

Everything that you create in any of the iLife applications will be available for you
to use within iMovie

Y

Bring photos, and video slips > Use music from your >
from either iPhoto or iMovie collection (iTunes) or write
your own with GarageBand

-

Get your finished movie into
a DVD using iDVD

806 “ My Great Movie (DV-NTSC)
| Ken Burns Effect
Star —  End . .
i iMovie
r Preview Mdin
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O ) (=) a O o = Pane Buttons
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et [i
Mode Switch =
Grp R Y s :
................... ..“,__.w"'""t;;qc,ossa‘]pc” 0:05:00 oP&23:12 total 3.36 CB available W Trash
I Playback Volume Slider \
Clips Controls
Disk Space
indicator
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“iMovihe can use many different types of media including: Quicktime files (.Mov), MP3'’s,
AIFF, WAVES, Picture Formats (Jpeg, Gif, etc). All of those can be inserted unto your
project directly or being called upon from any of the iLife applications.

iMovie HD

b}
A
-

‘ o

Create a New Project

-
,+7 | Open an Existing Project
—

-

§ Make a Magic iMovie

" My Great Movie 1 (DV-NTSO)

When you open iMovie you will need to select
from the following:

Create a New Project

Open an Existing Project

Make a Magic Movie:

Importing Media into iMovie

Files can directly drag into the Clips pane.
— Including still pictures or movie clips.
—~—_ 9 p p

- @ =<

.............................

P =<

In case you own a Digital Camcorder, you can
connect it to your computer via Firewire, and
then switch the Mode to Camera.

Then is very easy to download the footage into
the computer.

BE AWARE: DV VIDEO REQUIRES HUGE HARD
DRIVE SPACE

Any pictures previously imported into iPhoto will
also be available through the Photos pane.

~

ﬂ

! & iPhoto Library




[-5 - Importing Media into iMovie (cont)

Importing Audio into iMovie
All your Audio files that are inside iTunes will be available for you to use on your project.

iTunes Library ! 3] E]
] 4 ( /ﬂgv Artist Time
tos | Audia | v [y e s Fo_ockork_wend.ros 225 13
— \/ .ﬁ The Thieving Magpie Trans...stra 5:57
| ETHeme From & Cl... Trans...stra 1:48
} Ninth Symphony,...ent Trans...stra 3:52
E Mﬁrch From A Cl..ent, Trans...stra 7:06
} William Tell Overture Trans...stra 1:20
} Pﬁ.mp And Circu...ce March Trans...stra 4:35
All your iTunes Library or playlists will be at your disposal, as Lz Pame And Circu... IV Trans...stra| 1:38
well as a decent collection of Sound Effects. IR Timesteps (Excerp) Trans...stra 4:18
i) Overture To The Sun Terry...cker 1:46
E | Want Ta Marry...hthouse Erika Eigen 1:04
E William Tell Overture Trans...stra  3:02
} Suicide Scherzo...ent, Trans...stra 3:09
E NintH Syrﬁphony,...enl Trans...stra 1:39
iMovie Sound Effects [ :! E] Esiﬁgin' In The Rain Gene Kelly  2:37
i1 Main Title And First Alter...tates 4:43
Name Time E Love Theme Alter...tates 3:39
b Skywalker Sound Effects E Second Hallucination Alter...tates  5:15
b Standard Sound Effects E First Transformation Alter...tates 3:39 :
R e, Il amederamn Alrow toroc 317

Timeline vs. Clip Viewer

Clip Viewer: it shows clips regardless of duration as elements, it will also show any
transitions that happen between clips.

Timeline: it displays all the events (media) in sequential order. It also displays the
audio tracks, including the ones embedded within the video file. This is the best way
to edit either clips or audio. Due that the Clip viewer will only show the elements
without any way of editing them.

N

- @0 < .@/ﬁ/ff;\  m—c L [

I LU N 009:02,
|

| E’ #Eb m g K|

MO Oy 40r  Clip: | 100% [ 0:14:02 total duration
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Either if you transfer footage from your camera or just imported some clips into iMovie, once they
are in the clips pane you will be able to lay them out as your movie unfolds.

Be aware that the elements inside the Clips pane once they are dragged into the project they will
no longer appear inside the clips area. It is recommended that you hold the OPTION Key while you
are dragging them, that way a copy will remain inside Clips pane.

‘@06 "X My Great Movie 1 (DV-NTSC)

Drag files from the Clips pane
into the Clip viewer. REMEMBER
TO HOLD THE OPTION KEY
WHILE YOU ARE DOING IT.

If you are bringing video clips
they will hold the same
duration, in case of still
pictures, they will initially last
for 5 seconds.

0:15:00 total duratien 23.7 GB available | yf 6.5 MB 7

Adding Pictures to your Project (Photo Pane)

X # Ken Burns Effect
From the Photo Pane, any pictures that are part of your start C— End
iPhoto library can be inserted into your project, in the same __”7\'
fashion as the Clip pane: just drag the pictures into the clip | —=ilavens i
viewer. V' oreview—3
All pictures will have the Ken Burns Effect which adds a (_Update )
slow paced movement as well as Zooming into the - — EXE
picture, that movement. o =
F=3 3 -~ 7218
The Ken Burns Effect can be customized in terms of Speed, = - o
Zoom, and even the direction of the movement. G iPhoto Library :)
Q ) 0 items

Clips Fhotos Audio Titles Trans Effects iowvD

[lﬁl:l-iT--@]




[-7 - Importing Audio into your Project

—_—

Audio can be also imported into your project, just select the Audio pane and then you
will be able to search through your iTunes library

Eternal Sunshine Of The Spo | :] E]
[song Artst_ Time ™ \Afthe Audio pane you will find your entire iTunes collection as well as a decent list of
%Lhe::e « J;” f”"”t i;‘; Sound effects. Just click at the drop down menu at the top of the Audio pane.
[ Mr. Blue Sky ect...estra 5
i Collecting Things Jon Brion 1:13 e . . . . . . . R
ﬁum ; Dgw - The P..pree 3.03 To add an specific audio frack into your project just drag the file into your Timeline
[ Baokstore Jon Brian | 0:52 Viewer (in case you were in the clip viewer: it will turn into the Timeline
E It's The Sun The P...pree 5:33 oufomctﬁcolly).
EWada No Tad Lata ...hkar 5:54
[ Showtime Jon Brion (55 = @0 < |/|<_<\ ‘l\/b‘) |® 0 [ LIE HE'DS A:In | T:E;s 'r=s Ef:ls
1 Everybody's Go...earn Beck 5:54 NS NS
E Sidewalk Flight Jon Brion 031 : | | L B | | 0:24:10
1 Seme Kinda Shuffle Don Melsan 2:11 ! ﬁ‘* “ M
E Howard Makes It All Go Away Jon Brion 014 | gm | — ‘ S |
7 Semething The Willowz 2:23 ¢ 04 Light & Day
E Postcard Jon Brion 0:23 &
I/DI /f"é-:l."'l ' 26 songs WM o Te Elinc| 1nnn; el 1:N7-77 tatal duratinn 215 R awailabla | &9 187
i [ Place at Playhead |
IMOVIE ALLOWS TWO INDEPENDENT STEREO AUDIO TRACKS, PLUS IF YOUR VIDEO
: CONTAINS AUDIO INSIDE THAT WILL BE A THIRD AUDIO TRACK.
microphone: [ (I ITICIICICINTTICI RCe )

{lﬁl:l-t\T--QJ

Clips | Photos | Audia | Titles | Trans | Effects = iDVD

Y 0:24:10 ]

In order to edit your movie clips | Eg

to the audio or vice versa, you
can select to show Audio

Waveforms
Markers Advanced Winda

Switch to Clip Viewer #E !: _!

Scroll to Playhead 3P /1
Scroll to Se on : >

t ,u‘. .Jr_.ﬁ Just go under the View menu and select at the bottom of the menu: Show
Audio Waveforms

Zoom to S

Show Clip Volume Levels {+3§L

Show Audio Waveforms 3w

RENDERING

Rendering is a process that the computer requires to calculate and process changes to video/audio. E.g. Having a
picture in the clip viewer, then you decide to change the Ken Burns effect settings, in order for those changes to take
effect you will have to click on update. As a result a rendering process will take effect.

W Ken Burns Effect

rF
Start [ End After pressing Update a red S 0:23:08 ; ;
(—Reverse :] line will show ’rhe process of
—_—— rendending as is performed.
- The red line will indicate how
(_ Preview ) much longer it will take.

{ Update ]

|earninaceni’er.berl(|ee_edu



Video Editing: Any clip can be edited, meaning that you can rearrange scenes, change
their duration, change the speed of playback, efc.

It is important that you work within the Timeline viewer, since that will give you a better
idea of fimings and also in how to edit the video to audio.

In order to make cuts, you will have to physically divide the clip in two sections, then you
can delete the remainder of it. These cuts will not affect playback, although if they are
too abrupt you can also add Transitions (See next page).

Click in the Triangle (Playhead) to move around the
clips, once you find a place where you would like to b i 1

make a cut go to the Edit menu and select Split e

Video Clip at Playhead.

View Markers Advanced \
_an't Undo ¥7
7

Cut X
Copy #C
Paste T4y,
Clear

Select All HA
Select Similar Clips HA
Select None {+3A

Crop HEK

Split Video Clip at Playhead 3T

The end product will be a video clip divided in
two regions.

o



[-9 - Effects, Titles & Transitions

( Preview |

Effects:

Effect In Effect Out .
- movie.
00:00 10:00 10:00 00:00

[ Adjust Calars .
aged Fim old movie.

[ Black & white Black & White: Self explanatory
[HBrightness & Contrast
[ crystallize .
[ earthquake shaking.
[ Edge Work

[ Edges

[P Electricity

[ Fairy Dust

[FIFast/Slow/Reverse

[FFlash

PFog .

[P Ghost Trails b

Rotate: oW ———— caw

(m O =« T = = @

Clips | Photos | Audio | Titles  Trans | Effects | iDVD

Titles:
Titles can be added as captions, main titles, credits, or
even for closed caption.

It evens contains a feature to make Music Video Clips,
which it will add a little paragraph in the bottom left of the

» [ Converge N
screen ¥ Cross Through b
Arial Black Regular 3 " | Color
Size: 4 ——F—— A __ Over black
| QT margins
-M\- Creat Movie
-b-./R\cnrdo
( Preview )
(8 o « /7T m m o
Clips | Photos | Audio | Titles | Trans | Effects | iDVD
(@
5/
Speed: 00:01 ~—( %y 10:00
B Billow
[ Circle Closing
[ Circle Opening
[ Cross Dissolve
[ pisintegrate
[ElFade In
[HlFade Qut
[ Overlap oge .
Erus Transitions:
B radial Transitions are added to make video cuts a little more
Sl‘;’l’e'emwn bearable. A good transition will help your cuts to look
B Towirl smoother, although do not over use it.
EWarp Out
Elwash in
[Ewash out

|"Ea O <« T ®m = o |

Clips Photos  Audic Titles Trans | Effects ibvD
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Effects can be applied to an individual clip or to an entire

Aged Film: it adds dust and speckles to make look like and

Earthquake: it makes the movie look like everything is

(_ Preview |

= 02:24 + 1:18 = 04:12

Speed: 0:20 ————{F——— 400
Pause: (10 ———f }———— 4:00

[ 30 spin
» [[]Bounce Across U

[I]Bounce In To Center
b [E] Cartwheel
v [E]Centered
[ Centered Multiple

[l Centered Title

» [ Clip to Characters




Once you are done editing your movie you might want o find a medium to share it with

Iﬁg Edit  View Markers

New Project... #EN
Open Project... #*0
Open Recent >
Make a Magic iMovie...
Close Window HwW
Save Project #S
Save Project As...

Revert to Saved...
Import... 136l

From the File menu you

Email HomePage Videocamera

can select to Share,
which will allow you to
make a copy of your film
to be used as an e-mail,

© a <

iDVD QuickTime  Bluatooth

Email your movie to friends and family. This operation may

for a CD, DVD, etc.

everybody else.

FIN Edit  View Markers
New Project... 3EN
Open Project... HO
Open Recent >
Make a Magic iMovie...
Close Window EW
Save Project 35

Save Project As...
Revert to Saved...

take several minutes to complete.

Send email using: : Mail |+]

Name of saved movie: My Great Movie 1.mov

Your movie will be compressed to 10 frames per second, 160 x 120,
with monaural sound. Estimated size: 5.1 MB to 6.5 MB.

1 Share selected clips only

(Canee) )

Movie title: My Great Movie 1

Your video will be imported, and a movie will be created with an opening
title and the options you set below.

[ -
™ use | Cross Dissolve

Transitions go between the video clips to smoothly move from one scene to

the next.

A musical soundtrack allows you to play one of your own songs in the
background over the sound from the video.

# Send to iDVD

After the video is imported, and the movie has been created, iMovie will send
the project to iDVD where you can design and burn your own DVDs_

|+] transitions between scenes.

E Play a music soundtrack: Mo music selected

el ) (G

iDVD is part of the iLife suite, which creates
interactive menus for DVD's. E.g. After you finish
your movie, you want to make a DVD copy of it,

that includes features like behind the scenes,
interviews with the director (you) etc.iDVD is a
separate application which it will not be covered
in this class.

Import... <t 381
Share... f+3E
Save Frame... 3EF

Burn Project to Disc...
Show Info.. £

T
T ¥HE

Show Trash...
Empty Trash...

Magic iMovie is a feature that will allow to make
a quick version of your movie, just adding
fransitions arbitrarily as well as a music
soundtrack. This is just a quick fix, but it doesn't
give you a lot of different settings.

My Great DVD




[-11 - Learning Center (leamingcenter.berklee.edu)

150 Mass Ave, second floor, upstairs from the Media Center
(617) 747-2669

Training Sessions, Tutoring (Core Music & Software), MIDI Workstations, Laptop Stations (Hybrid)

i Berklee
college of
LEARNING CENTER e
| SITEPAGES | WELCOME TO THE LEARNING CENTER | NEWS & EVENTS |
+ Home (Twanita "] * News
« About Us z « "Put me on
* Training Sessions the LC Email list"
» Software Tutoring
» Core Music Tutoring ? HELP & SUPPORT
e, « Training Resources
| SHORTCUTS | o Ll - : --'ﬂ“!’_  Downloads
« Training Schedule ' U pr l." - - ! « For Faculty
/ Sign up - _ - e « Contact Staff
« Training Survey \ \ =g ﬂ' e A *“E « BLPP in the
- ® - )
+ Suggestion Box Training ion B Learning Center
] ] « FAQ
A » Berklee Links
% - Berklee.edu
= Berklee.net
= Campus Crusier
= Berklee Library
» Other Links
BLPP in the Learning Center
Learning Center Labs Training Sessions
g e e e Group training sessions on:
connect it fo a Full size Korg
Triton Keyboard, and get full REASON
support from skilled staff ~ FINALE
while you are working. Digital Performer 4
Garageband
-Music Workstations Web Design
-Video and Tape dubbing Laptop
stations-
Sign up at
learnin learningcenter.berklee.edu




WEB LINKS

http://www.picturetotv.com/kenburnseffect.htm
http://desktopvideo.about.com/od/advancedvideoediting/ss/kenburns_ro.htm
http://nslog.com/archives/2003/02/04/you_cant_escape_ken_burns_and_other_horrid_imovie_ughs.php
http://www.danslagle.com/mac/iMovie/video/2002.shtml

http://www.Igusd.k12.ca.us/imovie.html

http://www.apple.com/support/imovie/hottips/
http://www.g4tv.com/callforhelp/features/45997/Mac_Tip_iMovie_Special_Effects.html

http://www.apple.com/support/imovie/



